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Conformity / Supplemental Information:
The product complies with the requirements of the Low Voltage Directive 73/23/EEC and the EMC 
Directive 89/336/EEC (including 93/68/EEC) and carries the CE Marking accordingly. Contact the 
manufacturer for more information.

Notice: The manufacturer reserves the right to make any changes and 
improvements to the products described in this manual at any time and without 
notice. This manual is copyrighted. This document may not, in whole or in part, 
be copied, reproduced, translated, or converted to any electronic medium or 
machine readable form, for commercial purposes, without prior written consent 
from the copyright holder.

Note: Although we provide assistance on our products both personally and 
through our literature, it is the complete responsibility of the user to determine the 
suitability of any product to their application.

The manufacturer does not warrant or assume responsibility for the use of its 
products in life support applications or systems.

Wide-Range Laminar Flow Element Patent:
The wide-range laminar fl ow element and products using the wide-range laminar 
fl ow element are covered by U.S. Patent Number: 5,511,416.  Manufacture or use 
of the wide-range laminar fl ow element in products other than products licensed 
under said patent will be deemed an infringement.
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Thank you for purchasing an L Series Water Flow Meter or LC Water Flow Controller. Please take 
the time to fi nd and read the information contained in this manual. This will help to ensure that you 
get the best possible service from your instrument. This manual covers the following Cole-Parmer 
instruments:

 L Series 16 Bit Water Flow Meters  L-XXCCM-D
        L-XXLPM-D
 LC Series 16 Bit Water Flow Controllers  LC-XXCCM-D
        LC-XXLPM-D
 

Flow Measurement Operating Principle

All L or LC Series Water Flow Meters/Controllers accurately determine the fl ow rate by creating a 
pressure drop across a unique internal restriction, known as a Laminar Flow Element (LFE), and 
measuring differential pressure across it. The restriction is designed so that the water molecules are 
forced to move in parallel paths along the entire length of the passage; hence laminar (streamline) fl ow 
is established for the entire range of operation of the device. Unlike other fl ow measuring devices, in 
laminar fl ow meters the relationship between pressure drop and fl ow is linear. The underlying principle 
of operation of the 16 Series Flow Meters is known as the Poiseuille Equation:

Q = (P1-P2)πr4/8ηL           (Equation 1)

Where: Q  = Volumetric Flow Rate
P1 = Static pressure at the inlet
P2 = Static pressure at the outlet
r = Radius of the restriction
η = (eta) absolute viscosity of the fl uid
L = Length of the restriction

 Since p, r and L are constant; Equation 1 can be rewritten as:

Q = K (∆P/η)             (Equation 2)

Where K is a constant factor determined by the geometry of the restriction. Equation 2 shows the linear 
relationship between volumetric fl ow rate (Q) differential pressure (DP) and absolute viscosity (h) in a 
simpler form.

In order to have an accurate reading of the fl ow rate, the absolute viscosity of the fl uid must be 
established. The rate at which liquids change viscosity with changes in temperature is not linear. The 
relationship between temperature and viscosity for water is well established and Cole-Parmer L and 
LC Series units utilize a high accuracy temperature sensor and this relationship to provide an accurate 
viscosity reference. For this reason, these meters and controllers are generally recommended 
only for use with pure water. Any additives to water (such as antifreeze or disinfectants) that might 
affect the viscosity should be avoided. As shown in Equation 2, an error in viscosity between the actual 
fl uid and water will result in a 1:1 error percentage in the fl ow rate reported by the meter. For instance if 
the actual fl uid passing through the meter is 5% different than that of pure water at a given temperature, 
the reported fl ow rate will be 5% inaccurate.
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Flow Control Operating Principle

For the purposes of this explanation, the term “valve” will refer to the proportional control valve mounted 
on the controller. The term “controller” will refer to the fl ow meter and the measurement and control 
electronics portion of the device. In actuality, the whole device is generally referred to as a controller. 
The valve normally mounted downstream of the controller.

LC Series Flow Controllers ship with a normally closed proportional control valve. No fl ow will occur until 
the valve receives a voltage signal from the controller, and the controller will not send a voltage signal 
to the valve until the user provides a set point to the controller. The user can provide a set point either 
locally via the display and user interface buttons, or more commonly, by providing an external signal 
that corresponds to the fl ow range of the controller. This external signal can be an analog voltage or 
current signal such as a 0-5 Vdc or 4-20 mA signal, or a digital RS-232 signal via serial communication 
with a computer.

The controller utilizes what is called PID (Proportional, Integral, Derivative) loop control circuitry and 
software. The PID loop control works by repeatedly comparing the measured fl ow rate to the set 
point and incrementally adjusting the voltage signal to the valve in a continuous attempt to match the 
measured fl ow rate to the set point. For example, at any given time the controller looks at the measured 
fl ow rate and the set point, if the set point is higher than the measured fl ow rate, the controller will 
slightly increase the voltage signal to the valve and thus open it little more. If the set point is lower than 
the measured fl ow rate, the controller will slightly decrease the voltage signal to the valve and thus 
close it off a little more. This look, compare, and adjust “loop” occurs on the order of 1000 times each 
second.

LC Series Flow Controllers ship with a general PID tuning that is usually suffi cient for most applications. 
Occasionally an application will require the customer to change this tuning. The Proportional and 
Derivative terms can be fi eld adjusted in all LC controllers. In very general terms, the P term can be 
thought of as how fast the controller responds to change and the D term can be thought of as a damping 
factor.
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Installation

Plumbing

All L Series Meters and LC Series Controllers are equipped with female inlet and outlet port connections. 
Because the fl ow meters set up a laminar fl ow condition within the fl ow body, no straight runs of pipe 
are required upstream or downstream of the meter. The inlet and outlet ports are equal in size and 
symmetric (in-line). The port sizes (process connections) and mechanical dimensions for different fl ow 
ranges are shown on page 28.

Meters/controllers with 10-32 ports have o-ring face seals and require no further sealant or tape. On 
other meters/controllers, avoid the use of pipe dopes or sealants on the ports as these compounds 
can cause permanent damage to the meter should they get into the fl ow stream. Use of thread sealing 
Tefl on tape is recommended to prevent leakage around the threads. When applying the tape, avoid 
wrapping the fi rst thread or two to minimize the possibility of getting a piece of shredded tape into the 
fl ow stream. When changing fi ttings, always clean any tape or debris from the port threads.

It is also recommended that a 20 micron fi lter be installed upstream of meters/controllers with full scale 
ranges of 100CCM or less and a 50 micron fi lter be installed upstream of meters/controllers with full 
scale ranges above 100CCM.

Note: Avoiding long runs of small diameter tubing upstream or downstream of controllers will 
reduce water hammer.

Mounting

All L Series Meters and LC Series Controllers have mounting holes for convenient mounting to fl at 
panels. These meters are position insensitive and can be mounted in any orientation. The sizes and 
dimensions for the mounting holes are shown on pages 29-30.

Note: For applications that may continuously introduce occasional air bubbles to the fl ow stream 
upstream of the device, the device may be mounted upside down to prevent the bubbles from becoming 
trapped in the differential pressure sensor ports. If the device has been installed upside down, avoid 
using the bleed screws as water may leak into the electronics housing causing permanent damage that 
is not covered under warranty!

Application

Maximum operating line pressure is 100 PSIG (689 kPa). Caution: Exceeding the maximum specifi ed 
line pressure may cause permanent damage to the solid-state differential pressure transducer.

 If the line pressure is higher than the 100 PSIG (689 kPa), a pressure regulator should be used 
upstream from the fl ow meter to reduce the pressure to 100 PSIG (689 kPa) or less if possible. Although 
the meter’s operation is uni-directional, reversing the fl ow direction will infl ict no damage as long as the 
maximum specifi ed limits are not exceeded. The differential pressure sensor utilized in this fl ow meter/
controller is a very sensitive device capable of detecting minute differences in pressure.

Avoid installations (such as snap acting solenoid valves upstream) that apply instantaneous 
high pressure to the meter as permanent damage to the differential pressure sensor could 
result. This damage is not covered under warranty!
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Bleed Ports

Cole-Parmer L and LC Series fl ow meters and controllers are equipped with bleed ports on the front to 
aid in the removal of air bubbles from the differential pressure sensor ports. The bleed ports consist of 
a threaded hole with an 8-32 nylon tipped screw as shown in Figure 1. After installation or anytime it is 
suspected that air may be trapped in the sensor ports, bleed the ports as follows:

CAUTION: A small amount of water will leak from the device during this procedure.  Take necessary 
precautions to prevent the leaking water from damaging anything around the unit, taking special care 
to avoid any live electrical devices or lines.

With the meter/controller installed and line pressure applied, gently loosen the upstream bleed port 
screw 1-2 turns or until water begins to leak from the threads. DO NOT REMOVE THE SCREW as the 
port is subject to line pressures and injury, equipment damage, or loss of required parts may result!

Gently tap the fl ow body (a wooden or plastic screwdriver handle works well for this) to encourage air 
bubbles to exit the port.

Any air in the port will generally be removed as the water leaks out even though you may not see or 
hear it.

Gently tighten the screw until the leakage stops, taking care not to crush the nylon tip.

Repeat steps 1-4 with the second bleed port.

 
Figure 1. Bleed Ports

8-32 Nylon Tipped Bleed Screw
5/64 Hex  Loosen to Bleed
DO NOT REMOVE!
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Power and Signal Connections

Power can be supplied to your meter or controller through either the AC/DC adapter jack, or through the 
8 pin Mini-DIN connector as shown in Figure 2.

A 2.1mm, positive center, 9-30 Vdc AC/DC adapter rated for at least 100 mA is required to use the 
adapter jack in a fl ow meter. 

A 2.1mm, positive center, 12-18 Vdc AC/DC adapter rated for at least 300 mA is required to use the 
adapter jack in a fl ow controller. 

Cables can be purchased from the manufacturer (see Accessories on page 37) or they are available 
at local electronics suppliers. Alternatively, power can be supplied through the Mini-DIN connector as 
shown below:

7 8

1 2

3 4 5

AC/DC Adapter Jack

6

1

3

2

4 5

6 7 8

Pin Function Mini-DIN 
cable color

1 Inactive or 4-20mA Primary Output Signal Black

2 Static 5.12 Vdc or Secondary Analog Output (4-20mA, 5Vdc, 10Vdc) or 
Basic Alarm Brown

3 RS-232 Input Signal Red

4 Analog Input Signal = Remote Tare (Meters - see Figure 8)
                                = Set-Point In (Controllers - see Figure 3) Orange

5 RS-232 Output Signal Yellow
6 0-5 Vdc (or 0-10 Vdc) Output Signal Green
7 Power In (as descibed above) Blue
8 Ground (common for power, communications and signals) Purple

Note: The above pin-out is applicable to all the fl ow meters and controllers available with the Mini-
DIN connector. The availability of different output signals depends on the fl ow meter options ordered.
Underlined Items in the above table are optional confi gurations that are noted on the unit’s 
calibration sheet.

Figure 2. 8 Pin Mini-DIN Connector

CAUTION:Do not connect power to pins 1 through 6 as permanent damage can occur!

Note: Upon initial review of the pin out diagram in Figure 2, it is common to mistake Pin 2 (labeled 
5.12 Vdc Output) as the standard 0-5 Vdc analog output signal! In fact Pin 2 is normally a constant 
5.12 Vdc that refl ects the system bus voltage and can be used as a source for the input signal. This 
allows the user in the fi eld to run this output through a 50K ohm potentiometer and back into the analog 
set point pin to create a 0-5 Vdc set point source (see Figure 3).
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Analog Input Signal

Apply analog input to Pin 4 as shown in Figure 2.

Unless ordered otherwise, 0-5 Vdc is the standard analog input signal. Apply the 0-5 Vdc input signal 
to pin 4, with common ground on pin 8. The 5.12 Vdc output on pin 2 can be wired through a 50K ohm 
potentiometer and back to the analog input on pin 4 to create an adjustable 0-5 Vdc input signal source 
as in Figure 3 below.

7 6

5 4 3

2 1

8

5.12 Vdc

50 KOhm 
Potentiometer

0-5 Vdc

Figure 3.  Simple Method for Providing Set-Point to Controllers

Optional 0-10 Vdc: If specifi ed at time of order, a 0-10 Vdc input signal can be applied to pin 4, with 
common ground on pin 8.

Optional 4-20 mA: If specifi ed at time of order, a 4-20 mA input signal can be applied to pin 4, with 
common ground on pin 8.

RS-232 Digital Input Signal

If you will be using the RS-232 output signal, it is necessary to connect the RS-232 Output Signal 
(Pin 5), the RS-232 Input Signal (Pin 3), and Ground (Pin 8) to your computer serial port as shown in 
Figure 4. Adapter cables are available from the manufacturer (see Accessories page 30) or they can 
be constructed in the fi eld with parts from a local electronic supply house. In Figure 4, note that the 
diagrams represent the “port” side of the connections, i.e. the connector on top of the meter and the 
physical DB-9 serial port on the back of the computer. The cable ends will be mirror images of the 
diagram shown in Figure 4. (See page 20 for details on accessing RS-232 output and input.) 

RS-232 Digital Output Signal

If you will be using the RS-232 output signal, it is necessary to connect the RS-232 Output Signal (Pin 
5), the RS-232 Input Signal (Pin 3), and Ground (Pin 8) to your computer serial port as shown in Figure 
4. Adapter cables are available from the manufacturer or they can be constructed in the fi eld with parts 
from an electronics supply house. In Figure 4, note that the diagrams represent the “port” side of the 
connections, i.e. the connector on top of the meter and the physical DB-9 serial port on the back of the 
computer. The cable ends will be mirror images of the diagram shown in Figure 4. (See page 20 for 
details on accessing RS-232 output.)
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Standard Voltage (0-5 Vdc) Output Signal

All L and LC Series fl ow meters/controllers have a 0-5 Vdc (optional 0-10 Vdc) output signal available on 
Pin 6. This is generally available in addition to other optionally ordered outputs. This voltage is usually 
in the range of 0.010 Vdc for zero fl ow and 5.0 Vdc for full-scale fl ow. The output voltage is linear over 
the entire range. Ground for this signal is common on Pin 8.

Optional 0-10 Vdc Output Signal

If your meter/controller was ordered with a 0-10 Vdc output signal, it will be available on Pin 6.  (See the 
Calibration Data Sheet that shipped with your meter to determine which output signals were ordered.) 
This voltage is usually in the range of 0.010 Vdc for zero fl ow and 10.0 Vdc for full-scale fl ow. The 
output voltage is linear over the entire range. Ground for this signal is common on Pin 8.

Optional Current (4-20 mA) Output Signal

If your meter/controller was ordered with a 4-20 mA current output signal, it will be available on Pin 
1. (See the Calibration Data Sheet that shipped with your device to determine which output signals 
were ordered.) The current signal is 4 mA at 0 fl ow and 20 mA at the meter’s full scale fl ow. The output 
current is linear over the entire range. Ground for this signal is common on Pin 8. (Current output units 
require 15-30Vdc power.)

Note: This is a current sourcing device. Do not attempt to connect it to “loop powered “ systems.

Optional 2nd Analog Output Signal

You may specify an optional 2nd analog output on Pin 2 at time of order. (See the Calibration Data 
Sheet that shipped with your device to determine which output signals were ordered.) This output may 
be a 0-5 Vdc, 0-10 Vdc, or 4-20 mA analog signal that can represent any measured parameter. 

Note: This is a current sourcing device. Do not attempt to connect it to “loop powered “ systems.

7

4

6

21

DB-9 Serial Port

5

5----------Ground--------------------------------------Ground----------8
3----------Transmit------------------------------------Receive---------3
2----------Receive-------------------------------------Transmit--------5

8 Pin Mini-DIN Port

8

1 2 3 4 5

6 7 8 9
3

 

4 5
6 7 8

2

Figure 4. Mini-DIN to DB-9 Connection for RS-232 Signals
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5

3. Red (Transmit →)
2. Yellow (Receive ←) 

5. Purple (Ground)

3
2

Purple

Red
Yellow

Purple

Red
Yellow

5 4 3 2
1

9
8 7

6

Unit C

Unit B

Unit A

Female Serial Cable Front

Figure 5.  Typical Multiple Device (Addressable) Wiring Confi guration

An optional industrial connector is also available:

1
6

5

4
3

2

Pin Function Cable Color
1 Power In  ( + ) Red
2 RS-232 Output Blue
3 RS-232 Input Signal White
4 Remote Tare (Ground to Tare) Green
5 Ground (commom for power,

                     communications and signals)
Black

6 Signal Out (Voltage or Current as ordered) Brown

Figure 6. Optional Industrial Connector

Note: The above pin-out is applicable to all the fl ow meters and controllers ordered with the industrial 
connector. The availability of different output signals depends on the fl ow meter options ordered.
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L Series Water Flow Meter Operation

The L Series can have several screen “modes” depending on how the device is ordered. All L Series 
meters have a default Main Mode, Select Menu Mode, a Communication Select Mode and a Manufacturer 
Data Mode. (In addition your meter may have been ordered with the Totalizing Mode option, see page 
31.) The device defaults to Main Mode as soon as power is applied to the meter.

Note: L Series Flow Meters may also be powered with the 9 Volt Battery Pack described on page 32.

Main Mode

The main mode screen shows the fl ow in the units specifi ed at time of order, the line pressure in PSIG, 
and the process temperature in degrees Celsius.  The following parameters are displayed in the main 
mode as shown in Figure 7:

MODE

 PSIG         oC          Tare
  +23.47      +22.73

       
      CCM
        Water
    
  +0.000
  Volume                   Main

Figure 7. Main Mode Display, L Series Flow Meter

 The “MODE” button in the lower right hand corner toggles the display between modes.

Tare – Pushing the dynamically labeled Tare button in the upper right hand corner tares the fl ow meter 
and provides it with a reference point for zero fl ow. This is a very simple but important step in obtaining 
accurate measurements. It is good practice to “zero” the fl ow meter each time it is powered up and 
whenever a known zero fl ow condition exists. If the fl ow reading varies signifi cantly from zero after an 
initial tare, give the unit a minute or so to warm up and re-zero it. If possible, it is helpful to zero the unit 
near the expected operating pressure by positively blocking the fl ow downstream of the fl ow meter prior 
to pushing the “Tare” button. Zeroing the unit while there is any fl ow will directly affect the accuracy by 
providing a false zero point. It is not uncommon for a meter to read a small value when it is removed 
from the process line as water can “hang” in one or both of the differential pressure sensor ports. If the 
unit reads a signifi cant negative value when removed from the line and blocked, it is a good indication 
that it was given a false zero.

Note: A remote tare can be achieved by momentarily grounding pin 4 to tare as shown in Figure  8 on 
page 14.
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Line Pressure – Pressing the dynamically labeled PSIG button located in the upper left corner of the 
display will move the line gauge pressure to the primary display.

Line Temperature – Pressing the dynamically labeled °C button located in the upper middle of the 
display will move the process temperature to the primary display.

Volume – The volume fl ow rate is defaulted on the primary display. Pressing the dynamically labeled 
“Volume” button will move the volume fl ow rate to the primary display if another parameter is displayed 
there.

Flashing Error Message: Our fl ow meters and controllers display an error message (VOV = volumetric 
overrange, POV = pressure overrange, TOV = temperature overrange) when a measured parameter 
exceeds the range of the sensors in the device. When any item fl ashes on the display, neither the 
fl ashing parameter nor the fl ow measurement is accurate. Reducing the value of the fl ashing parameter 
to within specifi ed limits will return the unit to normal operation and accuracy.

Figure 8. Proper Set Up for Remote Tare on Meters (Momentarily ground Pin 4 to Tare)

Select Menu Mode

Pushing “Mode” once will bring up the “Select Menu” display. Push the button nearest your selection to 
go to the corresponding screen. Push “Mode” again to return to the Main Mode display. (Note: If your 
meter was ordered with Totalizing Mode option (page 31), pushing the “Mode” button once will bring up 
the “Totalizing Mode” display.  Pushing “Mode” a second time will bring up the “Select Menu” display.)

MODE

SELECT
MENU

Comm.      Mfg.
RS-232     Data      Menu

Figure 9. Select Menu Display
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Communication Select Mode

The Communication Select mode is accessed by pressing the button below “Comm. RS-232” on the 
Select Menu display. The screen will appear as shown in Figure 10 below.

Select

>
 Unit ID (A).....A
 Baud (19200)....19200
 Data Rate......Fast

Comm.
   UP       DOWN    RS-232

MODE

Figure 10. Communication Select Display

Unit ID – Valid unit identifi ers are letters A-Z and @ (see Note below). This identifi er allows the user 
to assign a unique address to each device so that multiple units can be connected to a single RS-232 
port on a computer. The Communication Select Mode allows you to view and/or change a unit’s unique 
address. To change the unit ID address, press the “Select” button in the upper left corner of the display 
until the cursor arrow is in front of the word “Unit ID”. Then, using the UP and DOWN buttons at the 
bottom of the display, change the unit ID to the desired letter. Any ID change will take effect when the 
Communication Select Screen is exited by pushing the MODE button.

Note: When the symbol @ is selected as the unit ID, the device will go into streaming mode when the 
Communication Select Mode is exited by pushing the MODE button. See the RS-232 Communications 
chapter in this manual for information about the streaming mode.

Baud – The baud rate (bits per second) determines the rate at which data is passed back and forth 
between the instrument and the computer. Both devices must send/receive at the same baud rate in 
order for the devices to communicate via RS-232. The default baud rate for these devices is 19200 
baud, sometimes referred to as 19.2K baud. To change the baud rate in the Communication Select 
Mode, press the “Select” button in the upper left corner of the display until the cursor arrow is in front 
of the word “Baud”. Then, using the UP and DOWN buttons at the bottom of the display, select the 
required baud rate to match your computer or PLC. The choices are 38400, 19200, 9600, or 2400 baud.
Any baud rate change will not take effect until power to the unit is cycled.

Data Rate – Changing the Data Rate affects the rate at which the instrument dumps its data in the 
streaming mode. Slow is ½ the Fast rate. The speed of the Fast rate is determined by the selected 
baud rate. It is sometimes desirable to reduce the data rate if the communication speed bogs down 
the computer’s processor (as is not uncommon in older laptops), or to reduce the size of data fi les 
collected in the streaming mode. To change the data rate in the Communication Select Mode, press the 
“Select” button in the upper left corner of the display until the cursor arrow is in front of the word “Data 
Rate”.  Then, using the UP and DOWN buttons at the bottom of the display, select either Fast or Slow. 
Any data rate change will be effective immediately upon changing the value between Fast and 
Slow.
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Manufacturer Data Mode

“Manufacturer Data” is accessed by pressing the “Mfg. Data” button on the Select Menu display (Figure 
7). The “Mfg 1” display shows the name and telephone number of the manufacturer. The“Mfg 2” display 
shows important information about your fl ow meter including the model number, serial number, and 
date of manufacture. 

MODE

Main

Cole-Parmer

Ph 800-323-4340
Fax 847-549-7676

Mfg 1

MODE

Main

Model L-10LPM-D
Serial No 27117
Date Mfg.11/07/2005
Calibrated By.DL

Software GP07R23 
Mfg 2

Figure 11. Manufacturer Data Displays
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LC Series Water Flow Controller Operation

The LC Series can have several screen “modes” depending on how the device is ordered. All LC Series 
controllers have a default Main Mode,a Select Menu Mode, a Control Setup Mode, a Communication 
Select Mode and a Manufacturer Data Mode. (In addition your controller may have been ordered with 
the Totalizing Mode option, see page 31.) The device defaults to Main Mode as soon as power is 
applied to the meter.

Main Mode

The main mode screen shows the fl ow in the units specifi ed at time of order, the line pressure in PSIG, 
and the process temperature in degrees Celsius.
 

MODE

 PSIG         oC         Set Pt.
  +23.47      +22.73       0.000

       
      CCM
        Water
    
  +0.000
  Volume                   Main

Figure 12. Main Mode Display, LC Series Water Flow Controller

The “MODE” button in the lower right hand corner toggles the display between the Main Display and 
the Select Menu Display.

Line Pressure – Pressing the dynamically labeled PSIG button located in the upper left corner of the 
display will move the line gauge pressure to the primary display.

Line Temperature – Pressing the dynamically labeled °C button located in the upper middle of the 
display will move the process temperature to the primary display.

Volume – The volume fl ow rate is defaulted on the primary display. Pressing the dynamically labeled 
“Volume” button will move the volume fl ow rate to the primary display if another parameter is displayed 
there.

Set Pt – The set point is shown in the upper right corner of the display. The set point cannot be adjusted 
from the main mode screen. (For information on changing the set point, see the Control Set Up Mode 
below.)

Flashing Error Message: Our fl ow meters and controllers display an error message (VOV = volumetric 
overrange, POV = pressure overrange, TOV = temperature overrange) when a measured parameter 
exceeds the range of the sensors in the device. When any item fl ashes on the display, neither the 
fl ashing parameter nor the fl ow measurement is accurate. Reducing the value of the fl ashing parameter 
to within specifi ed limits will return the unit to normal operation and accuracy.
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Select Menu Mode

Pushing “Mode” once will bring up the “Select Menu” display (Figure 9, page 14). Push the button 
nearest your selection to go to the corresponding screen. Push “Mode” again to return to the Main 
Mode display. (Note: If your meter was ordered with Totalizing Mode option (page 31), pushing the 
“Mode” button once will bring up the “Totalizing Mode” display.  Pushing “Mode” a second time will 
bring up the “Select Menu” display.)

Control Setup Mode
The Control Setup Mode is accessed by pressing the button labeled “MODE” until the dynamic label 
over the button reads “Control Setup” as shown in Figure 11 below. This mode allows the user to set 
up most parameters commonly associated with PID control. LC Series fl ow controllers allow the user 
to select how the set point is to be conveyed to the controller, what that set point is if control is local, 
and what the Proportional and Differential terms of the PID control loop will be. The UP and DOWN 
buttons for adjusting variables can be held down for higher speed adjustment or pressed repeatedly 
for fi ne adjustment. If your controller is diffi cult to reach or you prefer “dial up” set point adjustment, 
please consider our Local Set Point Module (LSPM) described on page 34.

MODE

 Select    Loop     Input

>P 200            >Analog
 D 500   >Volume   Serial
 AUT0on

     
         Local

 Set 0.00
Control

Up       Down     Setup

Figure 11.  LC Series Control Setup Display

Input – LC Series Flow Controllers normally ship defaulted to analog control as indicated in Figure 13 
above. To change how the set point will be conveyed to the controller push the button in the upper right 
hand corner just above the dynamic label “Input” until the arrow is directly in front of the desired option. 
The controller will ignore any set point except that of the selected input and it will remember which input 
is selected even if the power is disconnected.
Analog refers to a remote analog set point applied to Pin 4 of the Mini-DIN connector as described 
in the installation section of this manual. To determine what type of analog set point your controller 
was ordered with, refer to the Calibration Data Sheet that was included with your controller. 0-5 Vdc is 
standard unless ordered otherwise. Note that if nothing is connected to Pin 4, and the controller is set 
for analog control, the set point will fl oat. CAUTION! NEVER LEAVE A CONTROLLER WITH ANY NON-ZERO SET 
POINT IF NO PRESSURE IS AVAILABLE TO MAKE FLOW. THE CONTROLLER WILL APPLY FULL POWER TO THE VALVE IN AN 
ATTEMPT TO REACH THE SET POINT. WHEN THERE IS NO FLOW, THIS CAN MAKE THE VALVE VERY HOT!
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Serial refers to a remote digital RS-232 set point applied via a serial connection to a computer or 
PLC as described in the Installation and RS-232 sections of this manual.  CAUTION! NEVER LEAVE A 
CONTROLLER WITH ANY NON-ZERO SET POINT IF NO PRESSURE IS AVAILABLE TO MAKE FLOW. THE CONTROLLER WILL 
APPLY FULL POWER TO THE VALVE IN AN ATTEMPT TO REACH THE SET POINT. WHEN THERE IS NO FLOW, THIS CAN MAKE 
THE VALVE VERY HOT!
Local refers to a set point applied directly at the controller. For more information on changing the set 
point locally refer to the heading “Select” below. Local input must be selected prior to attempting to 
change the set point locally. CAUTION! NEVER LEAVE A CONTROLLER WITH ANY NON-ZERO SET POINT IF NO 
PRESSURE IS AVAILABLE TO MAKE FLOW.  THE CONTROLLER WILL APPLY FULL POWER TO THE VALVE IN AN ATTEMPT TO 
REACH THE SET POINT. WHEN THERE IS NO FLOW, THIS CAN MAKE THE VALVE VERY HOT!

Loop –  The LC is defaulted to volume fl ow.

Volume means that the controller is “closing the loop” on the volume fl ow rate. This means that when 
you give the controller a set point, the controller compares that set point to the measured volume fl ow 
rate and adjusts the valve to try to make the fl ow and the set point match. For the volume fl ow rate, the 
input signal (e.g. 0-5 Vdc) corresponds to the full-scale fl ow rate for the device.

Select – To avoid accidental changing of the PID loop parameters or the set point, the Control Setup 
mode defaults with the selector on a null position. To change the set point or the P and D PID loop 
parameters, push the button in the upper left corner just above the dynamic label “Select” until the 
selection arrow is pointing to the parameter you wish to change. When the parameter you wish to 
change is selected, it may be adjusted up or down with the buttons under the display below the dynamic 
labels “UP” and “DOWN”. Press the buttons repeatedly to make slow adjustments or hold them down 
to make fast adjustments.

P refers to the Proportional term of the PID loop. Before changing this parameter, it is good practice to 
write down the initial value so that it can be returned to the factory settings if necessary.

D refers to the Differential term of the PID loop. Before changing this parameter, it is good practice to 
write down the initial value so that it can be returned to the factory settings if necessary.

AUT0on / AUT0off refers to the standard auto-tare or “auto-zero” feature. It is recommended that the 
controller be left in the default auto-tare ON mode unless your specifi c application requires that it be 
turned off. The auto-tare feature automatically tares (takes the detected signal as zero) the unit when it 
receives a zero set point for more than two seconds. A zero set point results in the closing of the valve 
and a known “no fl ow” condition. This feature helps to make the device more accurate by periodically 
removing any cumulative errors associated with drift.

Set refers to the Set Point. This parameter may only be changed if “Local” is selected as the Input. See 
above for information on selecting the input. Using the UP and DOWN buttons, the set point may be 
adjusted between zero and the full-scale range of the controller.  CAUTION! NEVER LEAVE A CONTROLLER 
WITH ANY NON-ZERO SET POINT IF NO PRESSURE IS AVAILABLE TO MAKE FLOW. THE CONTROLLER WILL APPLY FULL POWER 
TO THE VALVE IN AN ATTEMPT TO REACH THE SET POINT. WHEN THERE IS NO FLOW, THIS CAN MAKE THE VALVE VERY 
HOT!
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Communication Select Mode

The Communication Select mode is accessed by pressing the button below “Comm. RS-232” on the 
Select Menu display. Please see page 15 for Communication Select mode instructions.

Manufacturer Data Mode

“Manufacturer Data” is accessed by pressing the “Mfg. Data” button on the Select Menu display (Figure 
9,page 14). The “Mfg 1” display shows the name and telephone number of the manufacturer. The“Mfg 2” 
display shows important information about your fl ow meter including the model number, serial number, 
and date of manufacture (Figure 11, page 16). 

RS-232 Output and Input

Confi guring HyperTerminal®:

Open your HyperTerminal® RS-232 terminal program (installed under the “Accessories” menu on 
all Microsoft Windows operating systems).
Select “Properties” from the fi le menu.
Click on the “Confi gure” button under the “Connect To” tab. Be sure the program is set for: 19,200 
baud (or matches the baud rate selected in the RS-232 communications menu on the meter) and 
an 8-N-1-None (8 Data Bits, No Parity, 1 Stop Bit, and no Flow Control) protocol.
Under the “Settings” tab, make sure the Terminal Emulation is set to ANSI or Auto Detect.
Click on the “ASCII Setup” button and be sure the “Send Line Ends with Line Feeds” box is not 
checked and the “Echo Typed Characters Locally” box and the “Append Line Feeds to Incoming 
Lines” boxes are checked. Those settings not mentioned here are normally okay in the default 
position.
Save the settings, close Hyperterminal® and reopen it.

In Polling Mode, the screen should be blank except the blinking cursor. In order to get the data streaming 
to the screen, hit the “Enter” key several times to clear any extraneous information. Type “*@=@” 
followed by “Enter” (or using the RS-232 communcation select menu, select @ as identifi er and exit the 
screen). If data still does not appear, check all the connections and com port assignments.

Changing From Streaming to Polling Mode: 
When the meter is in the Streaming Mode, the screen is updated approximately 10-60 times per second 
(depending on the amount of data on each line) so that the user sees the data essentially in real time. 
It is sometimes desirable, and necessary when using more than one unit on a single RS-232 line, to be 
able to poll the unit.
In Polling Mode the unit measures the fl ow normally, but only sends a line of data when it is “polled”. 
Each unit can be given its own unique identifi er or address. Unless otherwise specifi ed each unit is 
shipped with a default address of capital A. Other valid addresses are B thru Z.

Once you have established communication with the unit and have a stream of information fi lling your 
screen:

Type *@=A followed by “Enter” (or using the RS-232 communcation select menu, select A as identifi er 
and exit the screen) to stop the streaming mode of information. Note that the fl ow of information will 
not stop while you are typing and you will not be able to read what you have typed. Also, the unit 
does not accept a backspace or delete in the line so it must be typed correctly. If in doubt, simply hit 
enter and start again. If the unit does not get exactly what it is expecting, it will ignore it. If the line 
has been typed correctly, the data will stop.

1.

2.
3.

4.
5.

6.

1.
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You may now poll the unit by typing A followed by “Enter”. This does an instantaneous poll of unit 
A and returns the values once. You may type A “Enter” as many times as you like. Alternately you 
could resume streaming mode by typing *@=@ followed by “Enter”. Repeat step 1 to remove the 
unit from the streaming mode.

To assign the unit a new address, type *@=New Address, e.g. *@=B. Care should be taken not to 
assign an address to a unit if more than one unit is on the RS232 line as all of the addresses will be 
reassigned. Instead, each should be individually attached to the RS-232 line, given an address, and 
taken off. After each unit has been given a unique address, they can all be put back on the same 
line and polled individually.

Tareing via RS-232 (L Series only): Tareing (or zeroing) the fl ow meter provides it with a reference 
point for zero fl ow. This is a very simple but important step in obtaining accurate measurements. It is 
good practice to “zero” the fl ow meter each time it is powered up. If the fl ow reading varies signifi cantly 
from zero after an initial tare, give the unit a minute or so to warm up and re-zero it. If possible, it is helpful 
to zero the unit near the expected operating pressure by positively blocking the fl ow downstream of the 
fl ow meter prior to entering the Tare command. Zeroing the unit while there is any fl ow will directly affect 
the accuracy by providing a false zero point. If in doubt about whether the fl ow is positively blocked, 
remove it from the line and positively block both ports before entering the Tare command. If the unit 
reads a signifi cant negative value when removed from the line and blocked, it is a good indication that 
it was given a false zero. It is better to zero the unit at atmospheric pressure and a confi rmed no fl ow 
conditions than to give it a false zero under line pressure. To send a Tare command via RS-232, enter 
the following strings:

In Streaming Mode:  $$V<Enter>
In Polling Mode:  Address$$V<Enter>        (e.g. B$$V<Enter>)

Sending a Set Point via RS-232 (LC Series only): To send a set point via RS-232, “Serial” must be 
selected under the “Input” list in the control set up mode. To give controllers a set point, or change an 
existing point, simply type in a number between 0 and 65535 (2% over range), where 64000 denotes 
full-scale fl ow rate, and hit “Enter”. The set point column and fl ow rates should change accordingly. If 
they do not, try hitting “Enter” a couple of times and repeating your command. The formula for performing 
a linear interpolation is as follows:

Value = (Desired Set Point X 64000) / Full Scale Flow Range

For example, if your device is a 500 CCM full-scale unit and you wish to apply a set point of 125 CCM 
you would enter the following value:

  16000 = (125 CCM X 64000) / Full Scale Flow Range

If the controller is in polling mode as described in Changing from Streaming Mode to Polling Mode, the 
set point must be preceded by the address of the controller. For example, if your controller has been 
given an address of D, the set point above would be sent by typing:

  D16000 followed by “Enter”

2.

3.
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To adjust the Proportional and Differential (P&D) terms via RS-232 (LC Series only):

Type *@=A followed by “Enter” to stop the streaming mode of information.

To adjust the “P” or proportional term of the PID controller, type *R21   followed by “Enter”.

The computer will respond by reading the current value for register 21 between 0-65535. It is good 
practice to write this value down so you can return to the factory settings if necessary. Enter the value 
you wish to try by writing the new value to register 21. For example, if you wished to try a “P” term of 
220, you would type *W21=220 followed by “Enter” where the bold number denotes the new value.

The computer will respond to the new value by confi rming that 21=220. To see the effect of the change 
you may now poll the unit by typing A followed by “Enter”. This does an instantaneous poll and returns 
the values once. You may type A “Enter” as many times as you like. Alternately, you could resume 
streaming mode by typing *@=@ followed by “Enter”. Repeat step 3 to remove the unit from the 
streaming mode.

To adjust the “D” or proportional term of the PID controller, type *R22 followed by “Enter”.

The computer will respond by reading the current value for register 22 between 0-65535. It is good 
practice to write this value down so you can return to the factory settings if necessary. Enter the value 
you wish to try by writing the new value to register 22. For example, if you wished to try a “D” term of 
25, you would type *W22=25 followed by “Enter” where the bold number denotes the new value. 

The computer will respond to the new value by confi rming that 22=25. To see the effect of the change 
you may now poll the unit by typing A followed by “Enter”. This does an instantaneous poll and returns 
the values once. You may type A “Enter” as many times as you like. Alternately you could resume 
streaming mode by typing *@=@ followed by “Enter”. Repeat. 

You may test your settings for a step change by changing the set point. To do this type A32000 (A is the 
default single unit address, if you have multiple addressed units on your RS-232 line the letter preceding 
the value would change accordingly.) followed by “Enter” to give the unit a ½ full scale set point. Monitor 
the unit’s response to the step change to ensure it is satisfactory for your needs. Recall that the “P” term 
controls how quickly the unit goes from one set point to the next, and the “D” term controls how quickly 
the signal begins to “decelerate” as it approaches the new set point (controls the overshoot).
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Collecting Data:
The RS-232 output updates to the screen many times per second. Very short-term events can be 
captured simply by disconnecting (there are two telephone symbol icons at the top of the HyperTerminal® 
screen for disconnecting and connecting) immediately after the event in question. The scroll bar can be 
driven up to the event and all of the data associated with the event can be selected, copied, and pasted 
into Microsoft® Excel® or other spreadsheet program as described below.

For longer term data, it is useful to capture the data in a text fi le. With the desired data streaming to the 
screen, select “Capture Text” from the Transfer Menu. Type in the path and fi le name you wish to use. 
Push the start button. When the data collection period is complete, simply select “Capture Text” from 
the Transfer Menu and select “Stop” from the sub-menu that appears.

Data that is selected and copied, either directly from HyperTerminal® or from a text fi le can be pasted 
directly into Excel®. When the data is pasted it will all be in the selected column. Select “Text to 
Columns...” under the Data menu in Excel® and a Text to Columns Wizard (dialog box) will appear. 
Make sure that “Fixed Width” is selected under Original Data Type in the fi rst dialog box and click “Next”. 
In the second dialog box, set the column widths as desired, but the default is usually acceptable. Click 
on “Next” again.  In the third dialog box, make sure the column data format is set to “General”, and click 
“Finish”. This separates the data into columns for manipulation and removes symbols such as the plus 
signs from the numbers. Once the data is in this format, it can be graphed or manipulated as desired. 
For extended term data capture see: “Sending a Simple Script to HyperTerminal®” on page 24.

Data Format:
The data stream on the screen represents the fl ow parameters of the main mode in the units shown 
on the display. For L Series Flow Meters, there are 3 columns of data. The fi rst column is line pressure 
(normally in PSIG), the second column line temperature (normally in °C), and the third column is the 
volume fl ow rate in the units specifi ed at time of order and shown on the display.

 +014.70 +025.00 +4.123
+014.70 +025.00 +4.123
+014.70 +025.00 +4.123
+014.70 +025.00 +4.123
+014.70 +025.00 +4.124
+014.70 +025.00 +4.125

L Series Water Flow Meter Data Format

For LC Series Flow Controllers, there are 4 columns of data representing pressure, temperature, 
volume fl ow and set point. The fi rst column is line pressure (normally in PSIG), the second column is 
temperature (normally in °C), the third column is volume fl ow rate (in the units specifi ed at time of order 
and shown on the display), and the fourth column is the set point (also in the units specifi ed at time of 
order and shown on the display). For instance, if the meter was ordered in units of CCM, the display on 
the meter would read 2.004 CCM and the last two columns of the output below would represent volume 
fl ow and set point in CCM.

 +014.70 +025.00 +02.004 +02.004
+014.70 +025.00 +02.005 +02.004
+014.70 +025.00 +02.006 +02.004
+014.70 +025.00 +02.005 +02.004
+014.70 +025.00 +02.004 +02.004
+014.70 +025.00 +02.004 +02.004

LC Series Water Flow Controller Data Format
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Sending a Simple Script File to Hyperterminal®
It is sometimes desirable to capture data for an extended period of time. Standard streaming mode 
information is useful for short term events, however, when capturing data for an extended period of 
time, the amount of data and thus the fi le size can become too large very quickly. Without any special 
programming skills, the user can use Hyperterminal and a text editing program such as Microsoft Word 
to capture text at user defi ned intervals.

1. Open your text editing program, MS Word for example.
2. Set the cap lock on so that you are typing in capital letters.
3. Beginning at the top of the page, type A<Enter> repeatedly. If you’re using MS Word, you can tell how 
many lines you have by the line count at the bottom of the screen. The number of lines will correspond 
to the total number of times the fl ow device will be polled, and thus the total number of lines of data it 
will produce.

For example: A
 A
 A
 A
 A
 A
will get a total of six lines of data from the fl ow meter, but you can enter as many as you like.

The time between each line will be set in Hyperterminal.

4. When you have as many lines as you wish, go to the File menu and select save. In the save dialog 
box, enter a path and fi le name as desired and in the “Save as Type” box, select the plain text (.txt) 
option. It is important that it be saved as a generic text fi le for Hyperterminal to work with it.
5. Click Save.
6. A fi le conversion box will appear. In the “End Lines With” drop down box, select CR Only. Everything 
else can be left as default.
7. Click O.K.
8. You have now created a “script” fi le to send to Hyperterminal. Close the fi le and exit the text editing 
program.
9. Open Hyperterminal and establish communication with your fl ow device as outlined in the manual.
10. Set the fl ow device to Polling Mode as described in the manual. Each time you type A<Enter>, the 
meter should return one line of data to the screen.
11. Go to the File menu in Hyperterminal and select “Properties”.
12. Select the “Settings” tab.
13. Click on the “ASCII Setup” button.
14. The “Line Delay” box is defaulted to 0 milliseconds. This is where you will tell the program how often 
to read a line from the script fi le you’ve created. 1000 milliseconds is one second, so if you want a line 
of data every 30 seconds, you would enter 30000 into the box. If you want a line every 5 minutes, you 
would enter 300000 into the box.
15. When you have entered the value you want, click on OK and OK in the Properties dialog box.
16. Go the Transfer menu and select “Send Text File…” (NOT Send File…).
17. Browse and select the text “script” fi le you created.
18. Click Open.
19. The program will begin “executing” your script fi le, reading one line at a time with the line delay you 
specifi ed and the fl ow device will respond by sending one line of data for each poll it receives, when it 
receives it.

You can also capture the data to another fi le as described in the manual under “Collecting Data”. You 
will be simultaneously sending it a script fi le and capturing the output to a separate fi le for analysis.
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TROUBLESHOOTING
Display does not come on or is weak.
Check power and ground connections and supply voltage.

Flow reading is approximately fi xed either near zero or near full scale regardless of actual line 
fl ow.
Differential pressure sensor may be damaged. Avoid installations that can subject sensor to pressure 
drops in excess of 10 PSID. A common cause of this problem is instantaneous application of high-
pressure as from a snap acting solenoid valve upstream of the meter. Damage due to excessive 
pressure differential is not covered by warranty.

Displayed volumetric fl ow, pressure or temperature is fl ashing and message VOV, POV or TOV 
is displayed:
Our fl ow meters and controllers display an error message (VOV = volumetric overrange, POV = pressure 
overrange, TOV = temperature overrange) when a measured parameter exceeds the range of the 
sensors in the device. When any item fl ashes on the display, neither the fl ashing parameter nor the fl ow 
measurement is accurate. Reducing the value of the fl ashing parameter to within specifi ed limits will 
return the unit to normal operation and accuracy.

Meter reads negative fl ow when there is a confi rmed no fl ow condition.
This is an indication of an improper tare. If the meter is tared while there is fl ow, that fl ow is accepted as 
zero fl ow. When an actual zero fl ow condition exists, the meter will read a negative fl ow. Simply re-tare 
at the confi rmed zero fl ow condition. Also note that while the meter is intended for positive fl ow, it will 
read negative fl ow with reasonable accuracy (it is not calibrated for bi-directional fl ow) and no damage 
will result.

My controller does not respond to the set point.
Check the control set up screen to be sure the Input parameter selection matches the set point you 
are trying to use. Also, be sure that the unit was ordered for the type of analog signal you are trying to 
use.

After installation, there is no fl ow.
Cole-Parmer LC Series controllers incorporate normally closed valves and require a set point to operate. 
Check that your set point signal is present and supplied to the correct pin and that the correct input 
is selected under the Input list in the control set up mode screen. Also check that the unit is properly 
grounded.

The fl ow lags below the set point.
Be sure there is enough pressure available to make the desired fl ow rate. If either the set point signal line 
and/or the output signal line is relatively long, it may be necessary to provide heavier wires (especially 
ground wiring) to negate voltage drops due to line wire length. An inappropriate PID tuning can also 
cause this symptom if the D term is too large relative to the P term. 

Meter does not appear to be accurate when compared against another valid measurement of the 
physical fl ow (such as weight over time).
Water fl ow meters can normally be compared against one another provided there are no leaks between 
the two meters. One common cause of inaccuracy, inconsistency, or unusual readings is air bubbles 
trapped in one or both of the legs of the differential pressure sensor. Bleed the ports as described in 
this manual to remove this possibility.  Another possibility is that the water has some contaminant or 
additive, such as antifreeze, that affects the viscosity of the water. A third possibility is an improper tare 
error (see above).
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Controller is slow to react to a set point change or imparts an oscillation to the fl ow.
An inappropriate PID tuning can cause these symptoms. Use at conditions considerably different than 
those at which the device was originally set up can necessitate a re-tuning of the PID loop.

Flow fl utters or is jumpy.
The meters are very fast and will pick up any actual fl ow fl uctuations such as from a diaphragm pump, 
etc. Also, inspect the inside of the upstream connection for debris such a Tefl on tape shreds. Note: L & 
LC Series meters feature a programmable geometric running average (GRA) that can aid in allowing a 
rapidly fl uctuating fl ow to be read.

The output signal is lower than the reading at the display.
This can occur if the output signal is measured some distance from the meter as voltage drops in the 
wires increase with distance. Using heavier gauge wires, especially in the ground wire, can reduce this 
effect.

My controller oscillates wildly and/or exhibits very different reactions to the set point than I 
expect.
Conditions considerably different than those at which the device was originally set up can necessitate 
a re-tuning of the PID loop. Avoid long runs of small diameter tubing in the system, increase line size.

RS-232 Serial Communications is not responding.
Check that your meter is powered and connected properly. Be sure that the port on the computer to which 
the meter is connected is active. Confi rm that the port settings are correct per the RS-232 instructions 
in this manual (Check the RS-232 communications select screen for current meter readings). Close 
Hyperterminal® and reopen it. Reboot your PC.

Slower response than specifi ed.
L Series Meters and LC Series Controllers feature an RS-232 programmable Geometric Running 
Average (GRA).  Depending on the full scale range of the meter, it may have the GRA set to enhance the 
stability/readability of the display, which would result in slower perceived response time. If you require 
the fastest possible response time, please consult the factory for written instructions on adjusting the 
GRA.

Jumps to zero at low fl ow.
L Series Meters and LC Series Controllers feature an RS-232 programmable zero deadband. The 
factory setting is usually 0.5% of full scale. This can be adjusted via RS-232 programming between 
NONE and 6.375% of full scale. Contact the factory for more information.
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Maintenance and Recalibration

General: L and LC Series Water Flow Meters and Controllers require minimal maintenance. The primary 
cause of damage and/or long-term inaccuracy in these devices is contamination and/or corrosion 
damage. Water should be fi ltered for particulates or biological materials that may grow in the device. 
When removing these units from the line for any extended period of time, make an effort to remove all 
of the water from the device, as deposits of calcium or other soluble minerals can affect the accuracy 
of the device.

Recalibration: The recommended period for recalibration is once every year. Providing that the CLEAN, 
DRY, and NON-CORROSIVE mantra is observed, this periodic recalibration is suffi cient. A label located 
on the back of the meter lists the recalibration due date. The meter should be returned to the factory for 
recalibration near the listed due date. Before calling to schedule a recalibration, please note the serial 
number on the back of the meter. The Serial Number, Model Number, and Date of Manufacture are also 
available on the Manufacture Data 2 screen (page 16).

Cleaning: L and LC Series Flow Meters require no periodic cleaning. If necessary, the outside of the 
meter can be cleaned with a soft dry rag. Avoid excess moisture or solvents.

For repairs, recalibrations, or recycling of this product contact:
Cole-Parmer Instrument Co.

625 E. Bunker Court
Vernon Hills, IL 60061

USA
Ph. 800-323-4340
Fax 847-549-7676

email: info@coleparmer.com
Website: www.coleparmer.com

Warranty

This product is warranted to the original purchaser for a period of one year from the date of purchase 
to be free of defects in material or workmanship. Under this warranty the product will be repaired or 
replaced at manufacturer’s option, without charge for parts or labor when the product is carried or 
shipped prepaid to the factory together with proof of purchase. This warranty does not apply to cosmetic 
items, nor to products that are damaged, defaced or otherwise misused or subjected to abnormal use. 
See “Application” under the Installation section. Where consistent with state law, the manufacturer shall 
not be liable for consequential economic, property, or personal injury damages. The manufacturer does 
not warrant or assume responsibility for the use of its products in life support applications or systems.
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Technical Data for Water Flow Meters & Water Flow Controllers

Mechanical Specifi cations

Dimensional Drawings: pages 29-30

Basic Specifi cation Meters Controllers Description
Available Ranges 0.5CCM to 10LPM 50CCM to 500CCM¹ Full Scale

Accuracy ± 2 % Full Scale

Repeatability ± 2 % Full Scale

Operating Range 1% to 100% Full Scale Measure or Control

Typical Response Time 20 100 Milliseconds (Adjustable)

Operating Temperature +10 to + 50 ºCelsius

Zero Shift 0.02% Full Scale / ºCelsius / Atm

Span Shift 0.02% Full Scale / ºCelsius / Atm

Flow Rate 128% Measurable 102.4% Controllable Full Scale

Common Mode Pressure 100 PSIG

Supply Current 0.035 0.250 Amp

Supply Voltage 7—30² 12—18³ Vdc

Input /Output Signal Digital Pressure, Temperature or Flow RS-232 Serial 

Input /Output Signal Analog Volumetric Flow 0-5Vdc

Optional Input / Output Signal 
Secondary Analog Pressure, Temperature or Flow 0-5 Vdc; 0-10Vdc;4-20mA²

Electrical Connections 8 Pin Mini-DIN

Mounting Attitude Sensitivity 0% Tare after installation 

Wetted Materials 303 & 302 Stainless Steel, Viton®, Polyethermide. Controllers Add: 400 Series Stainless 
Steel, Brass. 

1. LCR Series high fl ow water controllers for applications with fl ows above 500CCM are available. Consult the 
factory for LCR specifi cations.

2. 15 volts required for 4-20mA output.
3. 24 volt applications should specify 24 volt coils.

Full Scale Flow Mechanical
Dimensions

Process
Connections1 Pressure Drop2 (PSID)

Meter
0.5CCM to 1CCM 4.5”H x 2.4”W x 1.1”D 10-32 Female Thread* 2.0

2CCM to 500CCM
4.8”H x 2.4”W x 1.1”D 1/8” NPT Female 

2.0

1LPM 4.0

2LPM 

5.0”H x 2.7”W x 1.1”D 1/4” NPT Female 

4.0

5LPM 10.0

10LPM 20.0

Controller
50CCM to 100CCM

4.8”H x 3.6”W x 1.1”D 1/8” NPT Female
5.0

200CCM to 500CCM 7.5

Units ≤1CCM F.S. are shipped with 10-32 Male Buna-N O-ring face seal to 1/8” Female NPT fi ttings.
These adaptor fi ttings were selected for customer convenience in process connection. It should be noted that the 1/8” Female 
NPT introduces additional dead volume. To minimize dead volume, please see Accessories for the 10-32 Male to 1/8”OD 
compression fi tting.

1. Compatible with Beswick®, Swagelok® tube, Parker®, face seal, push connect and compression adapter fi ttings.
2. Lower Pressure Drops Available, Please contact the manufacturer.
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Option: Totalizing Mode
L and LC Series Flow Meters and Controllers can be purchased with the Totalizing Mode option. This 
option adds an additional mode screen that displays the total fl ow (normally in the units of the main fl ow 
screen) that has passed through the meter or controller since the last time the totalizer was cleared. 
The Totalizing Mode screen shown below is accessed by pushing the “MODE” button until the label 
over it reads “Total”. If your meter is ordered with Totalizing Mode option, pushing the “Mode” button 
once will bring up the “Totalizing Mode” display.  Pushing “Mode” a second time will bring up the “Select 
Menu” display. Pushing it a third time will return you to the Main Mode Sreen.

 Hours    Volume  Clear
    0.3     0.00

           
           CC
           Water

   
+0.0 SCCM

    Total

MODE

Counter – The counter can have as many as six digits. At the time of order, the customer must specify 
the resolution of the count. This directly affects the maximum count. For instance, if a resolution of 
1/100ths of a liter is specifi ed on a meter which is totalizing in liters, the maximum count would be 
9999.99 liters. If the same unit were specifi ed with a 1 liter resolution, the maximum count would be 
999999 liters.

Rollover – The customer can also specify at the time of order what the totalizer is to do when the 
maximum count is reached. The following options may be specifi ed:

No Rollover – When the counter reaches the maximum count it stops counting until the counter is 
cleared.
Rollover – When the counter reaches the maximum count it automatically rolls over to zero and continues 
counting until the counter is cleared.
Rollover with Notifi cation – When the counter reaches the maximum count it automatically rolls over to 
zero, displays an overfl ow error, and continues counting until the counter is cleared.

Hours.–.The display will show elapsed time since the last reset in 0.1 hour increments. The maximum 
measurable elapsed time is 6553.5 hours (about nine months). The hours count resets when the “clear” 
button is pushed, an RS-232 clear is executed or on loss of power

Clear – The counter can be reset to zero at any time by pushing the dynamically labeled “Clear” button 
located above the upper right side of the display. To clear the counter via RS-232, establish serial 
communication with the meter or controller as described in the RS-232 section of the manual.  To reset 
the counter, enter the following commands:

 In Streaming Mode:  $$T <Enter>

 In Polling (addressable) Mode:  Address$$T <Enter>      (e.g. B$$T <Enter>)
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Option: 9 Volt Battery Pack

A Battery Pack that uses a common 9 Volt battery can be mounted to the top of your L Series Flow 
Meter. Power is passed from the battery to the fl ow meter through the 8 pin Mini-DIN connector. Output 
signals from the fl ow meter or pressure guage are passed through the male connector on the bottom 
of the battery pack to the female connector on top of the battery pack so the signals can be accessed 
normally. Turn the switch on top of the battery pack off when the meter is not in use. (Note: The Battery 
Pack cannot be used with Flow or Pressure Controllers)

Normal (9V alkaline) battery life is approximately 8 hours (30-40 hours with a 9V-lithium battery), however 
many factors can affect this. Replace the battery as often as required. A common indicator that the battery 
may be approaching the end of its life is a sharp increase in the temperature indicated on the meter. 
This false signal can result when the voltage drops below its normally regulated level. This can affect 
the accuracy of the meter so it is good practice to check that the temperature is approximately correct 
(25°C is about room temperature) or use a fresh battery especially if the measurement is critical.

Replacing the Battery:  

 The battery can be replaced with the battery pack installed on the fl ow meter.

Remove the four Phillips head screws from the back cover and gently remove it as shown in Figure 
9.
Remove the 9V battery, pulling the top of the battery out fi rst.
Remove the old battery from the harness and replace it with a new battery.
Install the new battery bottom end fi rst and replace the back cover so that the cushioning pad 
presses directly down on the battery.
Replace the four Phillips head screws.

Battery Pack Back Cover Removal

1.

2.
3.
4.

5.
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Wrench Access Hole

Wrench Access Hole

3/32 Hex Wrench

Trapped Mounting ScrewTrapped Mounting Screw

8 Pin Mini DIN Plug

9 volt
battery

Back of 
Meter

Battery Pack Installation/Removal

Battery Pack Installation and Removal: 

The battery must be removed before the battery pack can be installed or removed.

Remove the back cover of the battery pack and remove the battery if installed (see “Replacing the 
Battery”).
Carefully place the battery pack on top of the fl ow meter, being especially careful that the pins in the 
8 pin Mini-DIN plug are inserted properly into the 8 pin Mini-DIN socket on top of the fl ow meter. The 
two screws trapped in the bottom of the battery pack will not allow the plug to be completely inserted 
into the socket until they are screwed into place.
Slip the included hex wrench into either of the two holes on the top of the battery pack as shown in 
Figure 10 and start the screw into the corresponding threaded hole in the top of the meter.
Before the screw is tightened down all the way, move the hex wrench to the other hole and tighten 
the other screw gently down. Avoid over tightening the screw.
Return the hex wrench to the fi rst hole and tighten the fi rst screw gently down. Avoid over tightening 
the screw.
Install the battery and replace the back cover as described above.
Removal is the reverse of the installation.

1.

2.

3.

4.

5.

6.
7.
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Option: Local Set-Point Module
The Local Set-Point Module (LSPM) is designed to provide the user with a simple “turn of the dial” 

method of changing a fl ow or pressure controller 
set-point. 

The LSPM features a set-point control dial, a digital 
LED display which can be set to show either the 
set-point or the actual process measurement, and 
a tracking alarm LED which glows red whenever 
the actual process measure ment deviates from the 
set-point by more than 2% of full scale. This device 
is handy as a remote control/display device where 
the controller is out of convenient reach or view. 
It is supplied with a 6’ double ended cable to run 
between the controller and the LSPM. There is an 
additional 8 pin Mini-DIN port on the LSPM that 
allows access to normal signal/power functions of 
the controller’s Mini-DIN port.

8 Pin Mini-DIN connector connects to controller or to external device for power or output 
signal recording
LCD Display can display either the set-point or the process measurement.
Set-point Adjustment Knob provides simple “dial it in” process changes.
Display button switches display between actual set-point and measured fl ow parameter.
LED indicator switches from green to red when the measured parameter deviates from the 
set-point by more than 2% of full scale.

Operation Notes: The LSPM requires a double ended DC-62 8 Pin Mini-DIN cable connected 
between either the top or bottom connector socket of the LSPM to the connector socket on top of 
the controller. The two connector sockets on the LSPM are “pass through” connected so that the 
unused socket can be connected to a DC-61 single ended cable for connection of output signals 
and/or power. Appropriate power can be connected to either the LSPM or the controller, whichever 
is more convenient. Unless specially ordered otherwise, the LSPM utilizes the 5.12 Vdc output pin 
on the controller (pin 2) as a source. The 5.12 volts is connected through the potentiometer and 
returned to the controller on the set-point pin (pin 4) as a 0 though 5.12 Vdc input signal depending 
on the position of the adjustment knob.

•

•
•
•
•

 

DC-62 Double Ended 
8Pin Mini-DIN Cable
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CCM CCH LPM LPH CFM CFH
CFH 0.0021 0.00003 2.1189 0.035 60.0 1.0
CFM 0.000035 0.0000005 0.035 0.00059 1.0 0.0166
LPH 0.06 0.001 60.0 1.0 1699.0 28.316
LPM 0.001 0.000017 1.0 0.0166 28.316 0.4719
CCH 60.0 1.0 60000.0 1000.0 1699011.0 28317.0
CCM 1.0 0.0167 1000.0 16.667 28317.0 471.947

Flow Conversion Table:

Accessories
Battery Pack
Local Set-Point Module
8 Pin Male Mini-DIN connector cable, single ended, 6 foot length
8 Pin Male Mini-DIN connector cable, double ended, 6 foot length
Adaptor Cable, 8 Pin Mini-DIN to 9 Pin DB9 Serial, 6 foot length
AC to DC 12 Volt Power Supply Adapter
AC to DC 24 Volt Power Supply Adapter
AC to DC 12 Volt European Power Supply Adapter 
AC to DC 24 Volt European Power Supply Adapter
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Serial Number: ____________________________

Model Number: ____________________________

Calibration Certifi cate

(Store device calibration certifi cate in the pocket below.)


